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Motivation
public void ProcessImages()
{
foreach (Bitmap bmp in _inputStream)
{
Bitmap tmp_bmp = bmp;
tmp _bmp = doCrop(tmp_bmp);
tmp bmp = doHistogramEqualization(tmp_bmp);
tmp_bmp = doOilPainting(tmp_bmp);
tmp_bmp = doResize(tmp bmp);
tmp_bmp = doSharpen(tmp_bmp);
tmp _bmp = doSepia(tmp _bmp);
tmp _bmp = ConvertColorsTo32bppArgb(tmp bmp);
ConsumeBmp (tmp_bmp) ;
}
}
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Motivation

public void ProcessImages()

{

}
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#region TADL: S1+ => S2+ => S3+ => S4+ => S5+ => S6+ => S7+ => S8+ => S9
foreach (Bitmap bmp in _inputStream)

{

}

#endregion
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#region
#region
#region
#region
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52
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S9

Bitmap tmp_bmp = bmp;

tmp_bmp
tmp_bmp
tmp_bmp
tmp_bmp
tmp_bmp
tmp_bmp
tmp_bmp

doCrop(tmp_bmp);
doHistogramEqualization(tmp bmp);
doOilPainting(tmp bmp);
doResize(tmp_bmp);
doSharpen(tmp_bmp);
doSepia(tmp_bmp);
ConvertColorsTo32bppArgb(tmp bmp);

ConsumeBmp (tmp_bmp) ;
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#endregion
#endregion
#endregion
#endregion
#endregion
#endregion
#endregion
#endregion
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Ziel der Diplomarbeit ﬂ(".

Angabe der . .
Ermittlung von gewunschten P'g‘f;ﬁgﬂgfgme / Uberprifung der
Parallelisierungspotenzial parallelen T arametger Korrektheit
Architektur 9p

m Automatische Parallelisierung
sequenzieller Programme

m Bereitstellung von Tuningparametern
zur Optimierung auf verschiedenen
Plattformen
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Gliederung des Vortrags -\-\J(IT

Verwandte Arbeiten
Anforderungen

Automatische Transformation
Evaluation
Zusammenfassung

Ausblick
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Verwandte Arbeiten ACIT

TADL 1 [S10]
XJava [013]

RV+08, RV+10]
[TF10]
Compiler

*) Die Parallelisierungsvorschlage werden in TADL formuliert und enthalten dabei implizit Tuning-
Parameter.

Quellcode-Analyse
Erzeugung von
Parallelisierungs-
vorschlagen
Architektur-
beschreibungs-
sprache
Erzeugung von
parallelem
Programmen
Transformation
sequenzieller nach
paralleler
Quellcode
Autotuning-fahig
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Anforderungen -\\J(IT
m A;: Laufzeitbibliothek
= Ubernahme der Steuerung der parallelen Ausfiihrung und
Zurverfigungstellung von parallelen Architekturmustern
m A, Architekturbeschreibungssprache zur Angabe von
parallelen Architekturen

a Auf beliebige Quelltextbereiche bezugnehmende
Beschreibungssprache zur Angabe gewiinschter paralleler
Architekturen

m Aj Zutage Fordern von Tuningparametern zur
Laufzeitoptimierung

m Anpassbarkeit der parallelen Programme ohne neu kompilieren zu
mussen
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A, Laufzeitbibliothek (AT

ttttttttttttttttttt f Technology

m Erzeugung und Verwaltung von Faden
m Synchronisation wird vor dem Entwickler verborgen

a Implementierte Architekturen
a Fork/Join
a Pipeline
m Sequenz

m Verschachtelung moglich
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A, Laufzeitbibliothek

otufe 1 otufe 2
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A, Laufzeitbibliothek ﬂ(".

Pipeline r+. .-

T - Stufe 1 Stufe 2 Stufe 3

- ForkJoin

= =
Pipeline

|
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A, Laufzeitbibliothek ﬂ("'

Processable
Abstract Class

= Fields

& children

@ name

@ parent

9, _regionName
= Methods

@  AddChild

@, autoReadTuningParameters
@ Execute

.. T

_____________________________________________________

«
«
«

ForkJoin Sequence Pipeline kl. ausfiihrbare Einheit ¥
Class Class Class Class
= Processable = Processable =+ Processable =+ Processable
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A, Laufzeitbibliothek — kleinste ausfuhrbare
Einheit ﬂ(".
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Ll CE.I.UII L LJJ_L|||ﬂJ.J LlllP_U“llJ e U“lP" TTETTU EEJ.Ull
#region S2 tmp _bmp = doCrop(tmp_bmp); #endregion
Hivmamrd A €D dpn e — AAlld cdAasmamCAaiial Ao add Anm i mm mam Y HeoamArmmaerd e

class uniqueName__4S2 : TADL.Runtime.Processable

{

public override Dictionary<String, Object> Execute(Dictionary<String, Object> _pipeInVars)

{

ImageProcessing.ImageProcessor thisPtr = (ImageProcessing.ImageProcessor)_pipeInVars["this"];
Bitmap tmp_bmp = (Bitmap)_pipeInVars["tmp_bmp"];

tmp_bmp = thisPtr.doCrop(tmp_bmp);
_pipeInVars["tmp_bmp"] = tmp_bmp;
return _pipeInVars;
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A, Laufzeitbibliothek — Pipelinearchitektur

m Stromerzeugende Stufe

m Zentralstufe

s Ein- und Ausgabepuffer
a Endstufe

= Nur Eingabepuffer

| S— | S
D D
Stromerzeuger 9= | Zentralstufe =
o (M T
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m Tuningparameter

Puffer

Replikation

Fusion

Schrittgrole
Puffergrofie
Reihenfolgeerhaltung

—
(e b
~{ Zentralstufe 3= Endstufe
O
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A, Laufzeitbibliothek — Pipelinearchitektur
Auswirkung der Stufenreplikation

Sequenzielle —

Ausflhrung _

Ein Faden pro—
Stufe

Replikation

der ersten Stufe<
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Faden 1

Faden 1
Faden?
Faden 3

Faden 1

Faden?
Faden 3

Faden 4

< .
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A, Laufzeitbibliothek — Fork/Join-Architektur ﬂ(".

m Verklrzung der Laufzeit durch Anwendung der Fork/Join-
Architektur

Faden 1

Facen .

Faden 2
Faden 3 3 | 1 R
=’~ t2 ! :=
t -
a Tuningparameter:
a Aufgabenfusion
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A, Architekturbeschreibungssprache TADL ﬁ(".

m TADL = ,Tunable Architecture Description Language”

m TADL-Ausdrucke : —

a Operatoren o
_ => Pipeline A=>B=>C
m Bezeichner .
| Fork/Join AllB]|lC
; Sequenz A;B;C
+ Replikation A+
m Weitere Beispiele
a Sl+ => 52+ => S3+ => 54+ => S5+ => 56+ => S7+ => S8+ => S9
a A+=>B|C)+=>D
a DefindeProblem ; (ComputeX || SearchWord) ; DisplayResult
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TADL-Annotation — Beispiel ImageProcessing _\ﬂ(IT

public void ProcessImages()

{
#region TADL: S1+ => S2+ => S3+ => S4+ => S5+ => S6+ => S7+ => S8+ => S9

foreach (Bitmap bmp in _inputStream)

{
#region S1 Bitmap tmp_bmp = bmp; #endregion
#region S2 tmp _bmp = doCrop(tmp_bmp); #endregion
#region S3 tmp bmp = doHistogramEqualization(tmp bmp); #endregion
#region S4 tmp _bmp = doOilPainting(tmp bmp); #endregion
#region S5 tmp _bmp = doResize(tmp_bmp); #endregion
#region S6 tmp _bmp = doSharpen(tmp_bmp); #endregion
#region S7 tmp _bmp = doSepia(tmp bmp); #endregion
#region S8 tmp bmp = ConvertColorsTo32bppArgb(tmp _bmp); #endregion
#region S9 ConsumeBmp(tmp bmp); #endregion
}
#endregion
}
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A; Tuningparameter

Replikationsgrad

Fusion
a Pipelinestufenfusion
a Aufgabenfusion bei Fork/Join

Reihenfolgeerhaltung
Puffergrofe

Schrittgrol3e

Sequenzielle Ausflhrung
Vertellungsstrategie (*)
Alternative (*)

Parallele Rekursionstiefe (*)
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Tuningparameter — Format der Tuningdatel ﬂ("'

<Replication>
<ID>uniqueName__ 12S6</ID>
<Value>3</Value>
<TADL-Expression>S1+ => S2+ => S3+ => S4+ => S5+ =>

S6+ => S7+ => S8+ => S9</TADL-Expression>

<Project>ImageProcessing</Project>
<Document>ImageProcessing.cs</Document>
<Position>2766</Position>

</Replication>
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Automatische Parallelisierung ﬂ(".

Angabe der

Ermittlung von gewtunschten
Parallelisierungspotenzial parallelen
Architektur

Automatische
Parallelisierung /
Tuningparameter

Uberprifung der
Korrektheit

1 2 3 5

Erzeuge
kleinste
ausfuhrbare
Einheiten

Quelltext in Architektur-
Regionen informationen
ermitteln auslesen

Erzeuge Schreibe in

parallelen neue
Aufrufquelltext Quelltextdatei
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Automatische Parallelisierung — “(IT
© Erzeugung der kleinsten ausfiihrbaren EinheitertsL sl

1. Datenflussanalyse

2. Erzeuge Ein- und Ausgabe-Quelltext

3. Fuge Originalquelltext ein

4. Fuge vor Klassenvariablen und Methoden ,thisPtr.” hinzu

class uniqueName__4S2 : TADL.Runtime.Processable

{
public override Dictionary<String, Object> Execute(Dictionary<String, Object> _pipeInVars)
{
ImageProcessing.ImageProcessor thisPtr = (ImageProcessing.ImageProcessor)_pipeInVars["this"];
Bitmap tmp bmp = (Bitmap) pipeInVars["tmp_bmp"];
tmp_bmp = thisPtr.doCrop(tmp_bmp);
_pipeInVars["tmp_bmp"] = tmp_bmp;
return _pipeInVars;
}
}
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Automatische Parallelisierung — ﬂ("'
© paralleler Aufrufquelltext

if (!TADL.Runtime.TuningParameters.getSeqExecParam("sequencialExecution®”)) {
uniqueName 2S1 inst_uniqueName_ 2S1 = new uniqueName 2S1("uniqueName 2S1");

StreamGenerator inst uniqueName ©Pipeline StreamGenerator_inst_uniqueName_ @Pipeline =
new StreamGenerator_inst _uniqueName__@Pipeline(this );
TADL.Runtime.Pipeline inst_uniqueName__©@Pipeline =
new TADL.Runtime.Pipeline("uniqueName__@Pipeline");
inst_uniqueName__@Pipeline.setLoopStage(StreamGenerator inst uniqueName ©Pipeline);
inst_uniqueName_@Pipeline.AddChild(inst_uniqueName 251);

inst_uniqueName__@Pipeline.Initialize();
Dictionary<String, Object> result = inst _uniqueName_ @Pipeline.Execute();

¥
else {
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Evaluation ﬂ(".

Karlsruhe Institute of Technology

Programm Speedup Speedup % des Anzahl Anzahl
manuell Automatisch | manuellen | TADL-Ausdricke | Tuning-
parallelisiert parallelisiert Speedups paramter

Image- 7,19 7,18 99,9% 1 Pipeline 13

Processing

MergeSort 4,52 4,60 101,8% 1 Fork/Joinund 1 (*)

Sequenz
RayTracer 3,13 2 Pipelines 5und 7
(verschachtelt)

Desktop- (2,12) 1,67 (78,8%) 2 Pipelines 12 und 7

Search (verschachtelt)
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Zusammenfassung == et

m Gute Speedups automatisiert erreichbar ohne den
Quelltext verstehen zu missen

m Ergebnisse der Diplomarbeit auf drei Arten nutzbar:
s Nutzung der Laufzeitbibliothek durch den Entwickler
s Manuelle TADL-Annotation und automatische Parallelisierung
s Automatische Erzeugung von in TADL formulierten
Parallelisierungsvorschlagen und automatische Parallelisierung
a Optimierbar durch Autotuner
a Getrennte Tuningparameterraume sind einzeln optimierbar
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Ausblick -\\J(IT

ttttttttttttttttttt f Technology

a Erweiterung der Datenflussanalyse um fehlerhafte
Annotationen zu erkennen

a Die Datenflussanalyse wird bisher nur fur die direkt zur Ausfiihrung
bendtigten Variablen durchgefuhrt

a Was in aufgerufenen Methoden passiert, wird nicht untersucht
m Erweiterung/Verbesserung der bestehenden

Laufzeitbibliothek
m Austausch Dictionaries

a Implementierung der restlichen TADL-Operatoren
s Reduktion (-), Rekursion (\), Alternative (?)

a Portierung auf andere Laufzeitbibliothek
s Z.B. Intel Threading Building Blocks (TBB)
a Dabei sollte das Autotuning weiter mdglich bleiben
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Ende
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TADL-Annotation — Beispiel RayTracer ﬂ("'

#region TADL: S1S2+
[/for (int y = @; y < screenHeight; y++)
foreach (int y in Enumerable.Range(®, screenHeight - 1).TolList())

{
#region 5152
#region TADL: S1+ => S2+
[/for (Int x = @; X < screenWidth; x++)
foreach (int x in Enumerable.Range(@,screenWidth - 1).ToList())
{
#region S1
Color color = TraceRay(new Ray() {
start = scene.Camera.Pos,
Dir = GetPoint(x, y, scene.Camera) },
scene, 0);
#endregion
#region S2
setPixel(x, y, color.ToDrawingColor());
#endregion
}
#endregion
#endregion
}
#endregion
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Automatische Parallelisierung —
© paralleler Aufrufquelltext

if (!TADL.Runtime.TuningParameters.getSeqExecParam("sequencialExecution®")) {

uniguelName 251 inst_uniqueName 251 = new

unigquelName 452 inst_uniqueName 452

unigquelName 653 inst_uniqueName 653

unigquelName 854 inst _uniqueName 854 = new

uniguelame_ 1855 inst_uniqueName 1855 =
uniqueName 1256 inst uniqueName 1256 =
unigquelName 1457 inst _uniqueName 1457 =
uniguelame 1658 inst_uniqueName 1658 =
unigquelName 1759 inst unigqueName 1759 =

StreamGenerator inst uniqueNlame @Pipeline StreamGenerator_inst uniqueName_ ®Pipeline

new
new

new
new
new
new
new

unigueName_ 251("uniqueName_ _ 251");
unigueName_ _ 452("uniqueName _452");
unigueName_ 653("uniqueName_ 6S53");
unigueName_ 854("uniqueName__ 85S4");

unigueName _1055("uniqueName__1855");
uniqueName 12S6("uniqueName__1256");
uniqueName 14S7("uniqueName__ 1457");
unigueName _1658("uniqueName__1658");
uniqueName 1759("uniqueName__1759");

new StreamGenerator_inst unigqueName @Pipeline(this };

AT

Karlsruhe Institute of Technology

TADL .Runtime.Pipeline inst_uniqueName @Pipeline = new TADL.Runtime.Pipeline("uniqueName @Pipeline");

Dictionary<String, Object>input_inst_uniqueName__@Pipeline = new Dictionary<String, Object>();

inst_uniqueName_ @Pipeline.setloopStage(StreamGenerator_inst_uniqueName @Pipeline);

inst_unigqueName_@Pipeline.AddChild(inst_uniqueName 251);
inst_uniqueName @Pipeline.AddChild(inst_uniqueName _452);

inst_uniqueName_@Pipeline.AddChild(inst_uniqueName_ 653);

inst_unigqueName_@Pipeline.AddChild(inst_uniqueName 854);
inst_uniqueName_ @Pipeline.AddChild(inst_uniqueName__ 18S5);

inst_uniqueName_ @Pipeline.AddChild(inst_uniqueName 1256);
inst_uniqueName_ @Pipeline.AddChild(inst_uniqueName 1457);

inst_uniqueName_ @Pipeline.AddChild(inst_uniqueName_ 1658);
inst_unigqueName_ @Pipeline.AddChild(inst_uniqueName_ 1759);

inst_uniqueName__@Pipeline.Initialize();

Dictionary<String, Object> result = inst_uniqueMName_ OPipeline.Execute(input_inst uniqueName_@Pipeline);

¥
else {
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